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A B O U T  T H I S  P E O P L E B O O K

This documentation describes the PeopleSoft Upgrade Assistant.  The Upgrade Assistant is an

innovative tool designed to assist you in performing PeopleSoft Application Upgrades.  The

Upgrade Assistant contains a template (based on your purchased product) with the upgrade steps

included.  You choose each step to perform in the upgrade process.  The Upgrade Assistant then

runs each step by launching programs and processes, monitoring the progress, performing the

navigation needed to complete the step (for example, navigating to the correct panel and menu)

and checking for errors.  In addition, the Upgrade Assistant displays documentation relevant to

the current step.

The Upgrade Assistant can improve the quality of your upgrade, reduce errors, and shorten the

amount of time it takes to complete an upgrade.  In addition, the Upgrade Assistant enables you

to run certain steps in the upgrade unattended.  During the unattended process, the Upgrade

Assistant can inform you, by email, if errors occur.

This documentation describes how to install and use the PeopleSoft Upgrade Assistant.  In this

documentation, you will learn how to load your upgrade template, set step properties, and run

your upgrade process.  The Upgrade Assistant also enables you to configure certain options for

your upgrade process.

The Upgrade Assistant PeopleBook contains the following chapters:

Installing the Upgrade Assistant describes the installation process.

Using the Upgrade Assistant describes how the Upgrade Assistant is organized and how to
navigate through the interface.

Defining the Upgrade Template explains how to populate your upgrade template with the
predefined upgrade steps and define the properties for each step in your upgrade.

Creating and Running the Upgrade Job describes the process for creating and running your

upgrade.

Configuring and Editing Options describes how to create custom templates and configure and

modify options in your upgrade template.

Describing Types and Options is a functional reference to the process types and upgrade options

available in the Upgrade Assistant.

Before You Begin

This documentation assumes you have a basic understanding of the PeopleSoft system.  One of

the most important components to a successful upgrade of your PeopleSoft installation is your

onsite experience.  You need to be familiar with your operating hardware environment and have

the necessary skills to support that environment.  You should also have a working knowledge of
SQL and SQL command syntax.



P E O P L E T O O L S  8 . 1 2  U P G R A D E  A S S I S T A N T  P E O P L E B O O K J A N U A R Y  2 0 0 1

P R E F A C E      v i i i P E O P L E S O F T  P R O P R I E T A R Y  A N D  C O N F I D E N T I A L

PeopleSoft recommends that, prior to performing your upgrade, you have completed at least one

PeopleSoft introductory training course.  If you want additional information about PeopleSoft

training courses, please refer to the Education category on Customer Connection.

Related Documentation

To add to your knowledge of PeopleSoft applications and tools, you may want to refer to the

documentation of the specific PeopleSoft applications your company uses.  You can access

additional documentation for this release from PeopleSoft Customer Connection

(www.peoplesoft.com).  We post updates and other items on Customer Connection, as well.  In

addition, documentation for this release is available on CD-ROM and in hard copy.

Important!  Before upgrading, it is imperative that you check PeopleSoft Customer

Connection for updates to the upgrade instructions.  We continually post updates as we

refine the upgrade process.

Documentation on the Internet

You can order printed, bound versions of the complete PeopleSoft documentation delivered on

your PeopleBooks CD-ROM.  You can order additional copies of the PeopleBooks CDs through

the Documentation section of the PeopleSoft Customer Connection Web site:

http://www.peoplesoft.com/

You’ll also find updates to the documentation for this release on Customer Connection.  Through

the Documentation section of Customer Connection, you can download files to add to your

PeopleBook library.  You'll find a variety of useful and timely materials, including updates to the
full PeopleSoft documentation delivered on your PeopleBooks CD.

Documentation on CD-ROM

Complete documentation for this PeopleTools release is provided in HTML format on the

PeopleTools PeopleBooks CD-ROM.  The documentation for the PeopleSoft applications you

have purchased appears on a separate PeopleBooks CD for the product line.

Hardcopy Documentation

To order printed, bound volumes of the complete PeopleSoft documentation delivered on your

PeopleBooks CD-ROM, visit the PeopleSoft Press Web site from the Documentation section of

PeopleSoft Customer Connection. The PeopleSoft Press Web site is a joint venture between

PeopleSoft and Consolidated Publications Incorporated (CPI), our book print vendor.
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We make printed documentation for each major release available shortly after the software is first

shipped.  Customers and partners can order printed PeopleSoft documentation using any of the

following methods:

Internet From the main PeopleSoft Internet site, go to the

Documentation section of Customer Connection.  You can

find order information under the Ordering PeopleBooks

topic.  Use a Customer Connection ID, credit card, or

purchase order to place your order.

 PeopleSoft Internet site: http://www.peoplesoft.com/.

Telephone Contact Consolidated Publishing Incorporated (CPI) at

800 888 3559.

Email Email CPI at callcenter@conpub.com.

Typographical Conventions and Visual Cues

To help you locate and interpret information, we use a number of standard conventions in our

online documentation.

Please take a moment to review the following typographical cues:

monospace font Indicates PeopleCode.

Bold Indicates field names and other page elements, such as

buttons and group box labels, when these elements are

documented below the page on which they appear.  When

we refer to these elements elsewhere in the

documentation, we set them in Normal style (not in bold).

We also use boldface when we refer to navigational paths,

menu names, or process actions (such as Save and Run).

Italics Indicates a PeopleSoft or other book-length publication.

We also use italics for emphasis and to indicate specific

field values.  When we cite a field value under the page on

which it appears, we use this style: field value.

We also use italics when we refer to words as words or

letters as letters, as in the following: Enter the number 0,

not the letter O.

KEY+KEY Indicates a key combination action.  For example, a plus

sign (+) between keys means that you must hold down the

first key while you press the second key.  For ALT+W,

hold down the ALT key while you press W.
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Jump links Indicates a jump (also called a link, hyperlink, or

hypertext link).  Click a jump to move to the jump

destination or referenced section.

Cross-references The phrase For more information indicates where you can

find additional documentation on the topic at hand.  We

include the navigational path to the referenced topic,

separated by colons (:).  Capitalized titles in italics

indicate the title of a PeopleBook; capitalized titles in

normal font refer to sections and specific topics within the

PeopleBook.  Cross-references typically begin with a

jump link.  Here's an example:

For more information, see Documentation on CD-ROM in

About These PeopleBooks: Related Documentation.

• Topic list Contains jump links to all the topics in the section.  Note

that these correspond to the heading levels you'll find in

the Contents window.

Name of Page or Dialog Box

Opens a pop-up window that contains the named page or

dialog box.  Click the icon to display the image.  Some

screen shots may also appear inline (directly in the text).

Text in this bar indicates information that you should pay particular attention to as you work

with your PeopleSoft system. If the note is preceded by Important!, the note is crucial and

includes information that concerns what you need to do for the system to function properly.

Text in this bar indicates For more information cross-references to related or additional

information.

Text within this bar outlined in red indicates a crucial configuration consideration.  Pay very

close attention to these warning messages.

Comments and Suggestions

Your comments are important to us.  We encourage you to tell us what you like, or what you

would like changed about our documentation, PeopleBooks, and other PeopleSoft reference and

training materials.  Please send your suggestions to:



J A N U A R Y  2 0 0 1 P E O P L E T O O L S  8 . 1 2  U P G R A D E  A S S I S T A N T  P E O P L E B O O K

P E O P L E S O F T  P R O P R I E T A R Y  A N D  C O N F I D E N T I A L P R E F A C E      x i

PeopleTools Product Documentation Manager

PeopleSoft, Inc.

4460 Hacienda Drive

Pleasanton, CA  94588

Or send comments by email to the authors of the PeopleSoft documentation at:

DOC@PEOPLESOFT.COM

While we cannot guarantee to answer every email message, we will pay careful attention to your

comments and suggestions.  We are always improving our product communications for you.
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Installing the Upgrade Assistant

In this task, you will perform steps to install the Visual Basic Runtime Module and the
PeopleSoft Upgrade Assistant.  This task includes the following:

• Install Visual Basic 6.0 Runtime Module

• Install the Upgrade Assistant

Install Visual Basic 6.0 Runtime Module

Visual Basic 6.0 Runtime Module SP4 must be installed on your machine prior to installing the

Upgrade Assistant.   The service pack can be downloaded from the following website:

http://support.microsoft.com/support/kb/articles/Q235/4/20.asp

If you have not yet installed Visual Basic 6.0 Runtime Module SP4, you may receive the

following error message when you attempt to run or install the PeopleSoft 8 Upgrade Assistant:

Install the Upgrade Assistant

Perform the steps in the task to install the PeopleSoft Upgrade Assistant.

To install the PeopleSoft Upgrade Assistant:

1. From the PS_HOME/Setup/Upgrade Assistant directory, run Setup.exe.   The Welcome

screen appears.

2. Select Next.    The PeopleSoft Upgrade Assistant 8.12 screen appears:
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3. You can accept the default Destination Folder or specify another Destination Folder.

4. Select Next.  The Start Copying Files screen appears, as follows:

5. If you want to review or change any settings, click Back.  If you are satisfied with your

setting, click Next to begin copying files.  The Upgrade Assistant copies files to the

designated directory.   The Setup Complete screen appears:
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6. Click Finish to complete the Setup process.

7. You can open the Upgrade Assistant by selecting Start, Programs, PeopleSoft 8, Upgrade

Assistant.
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Using the Upgrade Assistant

This chapter describes how the Upgrade Assistant is organized and how to navigate through the
interface.

The Upgrade Assistant consists of two views — the Upgrade Template view and the Job Status
view — and corresponding toolbar menus for each view.

Upgrade Template View

On the Upgrade Template view, you can open or create an upgrade template, view the upgrade

steps, specify step properties, view step descriptions and properties, and view upgrade

instructions.

Upgrade Template Sections

The Upgrade Template view is divided into three main sections; the Template Tree, the

Description and Properties section, and the Documentation Window, as shown in the example

below:
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Template Tree

The Tree section displays the task and steps for your selected upgrade product.  Tasks are section

levels that contain one or more steps.  Steps are the actual upgrade steps you select to run your

upgrade job.  During the upgrade process, you will assign properties at the step level, not the task

level.  The following example displays the task and steps in the upgrade template:

You can expand a task, to display the steps within the task, by selecting the plus (+) sign next to

the task name.  You will expand a task before setting up step properties during the upgrade

process.

You can also set the tasks in the tree structure to automatically expand when you open your

template.
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For more information about expanding tasks, see Specifying General Settings.

Description and Properties

This section displays the default properties assigned to each step, as well as the step properties

you designate for each step.  Each time you assign properties for a step in your upgrade, the

Upgrade Assistant displays your selected properties in this section.

Documentation Window

This section displays the instructions for your current step; for example, if you select the step

titled "Update Statistics," the Upgrade Assistant displays the instructions for that step.

Note. You can also download printed instructions for your upgrade on Customer

Connection, Library, Upgrade Documentation, then choose the category for your upgrade

product.

Upgrade Template Toolbar Menus

The Upgrade Template Toolbar contains menus that enable you to create new templates, open
existing templates, specify step properties, and specify general settings.

File Menu

The File menu on the Upgrade Template toolbar contains options that enable you to create a new

upgrade template, open an existing upgrade template, and save your upgrade template.

Command Description

New Upgrade Template Select this option to create your own upgrade

template.  After creating your own template,

you can insert steps, scripts, and procedures

to customize your upgrade.

Open Upgrade Template Select this option to load a PeopleSoft-

delivered template for your upgrade product.

When you select this option, the Upgrade

Assistant loads the template with your

selected upgrade product line.
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Command Description

Save Upgrade Template Select this option to save your upgrade

template and the properties and

configurations you have designated for the

template.

Edit Menu

The Edit menu on the Upgrade Template view enables you to insert or delete information for your

upgrade template.

Command Description

Step Properties Enables you to set step properties for each

step in your upgrade.  On the Step Properties

dialog box, you will specify properties that

determine the conditions that apply when you

run the upgrade process.

Insert Task Enables you to insert a task into an existing

or new upgrade template.  A task serves as a

section head for one or more steps.

Delete Task Enables you to delete a task from an upgrade

template.

Insert Step Enables you to insert a step into an upgrade

template.

Delete Step Enables you to delete a step from an upgrade

template.

Rename Enables you to rename an existing task or

step in an upgrade template.

Set Documentation Directory Enables you to specify the directory in which

your upgrade documentation is stored.  The

Upgrade Assistant loads the upgrade

documentation for viewing during the

upgrade process.

Options Menu

The Options Menu on the Upgrade Template view enables you to edit general settings, specify

email settings, and merge templates.
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Command Description

Upgrade Assistant Enables you to specify general settings to

display the entire template tree.  In addition,

you can specify email settings to

automatically notify you of any errors

encountered during the upgrade process.

Merge Templates Enables you to merge an existing upgrade

template with a new upgrade template.

Job Status View

On the Job Status view, you can create a new upgrade job, open an existing upgrade job, run the

upgrade process, and view the job status of each step in your upgrade.

Job Status Sections

The Job Status view contains two sections; the Template Tree and the Status Grid, as shown

below:
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Template Tree

On the Job Status view, the Template Tree indicates the status for each step in your upgrade.  The

status is indicated by the following symbols:

Name Symbol Description

Run This green icon indicates that the Upgrade

Assistant will run this step or process.

Stop This red icon indicates that the Upgrade Assistant

will stop on this process.

Restart Indicates a restart process.  The Upgrade Assistant

will stop on these processes and you will have to

restart the Upgrade Assistant after you complete

the manual process.

Processing Indicates that the process is running.

Error Indicates an error.

Complete Indicates that the step is complete.
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Status Grid

The Status Grid displays the current step or process and provides information about it.  The Status

Grid includes the following:

Column Description

Step Description When you highlight a task or step in the

Template Tree section, the Upgrade Assistant

displays the step in the Status Grid.

Start Time Indicates the run start time of the step or

process.

End Time Indicates the run end time of the step or

process.

Duration Indicates the run duration of the step or

process.

Total Duration Indicates the run duration of all steps you

have run up to that point in the upgrade.

Status Indicates the current status of the step or

process; for example:

run, stop, restart, error, complete

Job Status Toolbar Menus

The Job Status Toolbar contains menus that enable you to create a new upgrade job, open an

existing upgrade job, edit the job status, edit the database configuration, specify general settings

and email settings, and merge templates.

File Menu

The File menu on the Job Status view toolbar contains options that enable you to create a new

upgrade job, open an existing upgrade job, or save an upgrade job.

Command Description

New Upgrade Job Enables you to create a new upgrade job

from an existing upgrade template.

Open Upgrade Job Enables you to open a existing upgrade job.

Save Upgrade Job Enables you to save changes to your current

upgrade job.
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Edit Menu

The Edit menu on the Job Status view toolbar enables you to modify the status of a step or

process in your upgrade.

Command Description Keyboard Shortcut

Run Enables you to change the

status of a step or process to

Run.

F4

Stop Enables you to change the

status of a step or process to

Stop.

F5

Restart Enables you to change the

status of a step or process to

Manual.

F6

Complete Enables you to change the

status of a step or process to

Complete.

F7

View Log Enables you to view output

generated from running the

step.

View Menu

The View Menu on the Job Status view toolbar enables you to view the documentation relevant to

the current step.

Options Menu

The Options Menu on the Job Status view toolbar enables you to edit your database

configuration, general settings, and email settings.  In addition, you can merge upgrade templates.

Command Description

Database Configuration Enables you to set your database

configuration, specify directories and

products, set profiles and run locations, and

specify import and export settings.

Upgrade Assistant Enables you to specify general settings to

display the entire template tree.  In addition,

you can specify email settings to

automatically notify you of any errors

encountered during the upgrade process.
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Command Description

Merge Templates Enables you to merge an existing upgrade

template with a new upgrade template.  This

option is used primarily for maintenance

releases.
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Defining the Upgrade

The PeopleSoft Upgrade Assistant uses a template for each product line and release you are

upgrading (for example, HRMS 7.5 to 8.0).  The Upgrade Template contains the tasks, steps,

SQL scripts, Data Mover scripts, SQRs, and Application Designer tasks associated with the

upgrade.  In this chapter, you will load the template into the Upgrade Assistant.  Then you will

define the properties for each step in your upgrade.

Select the Upgrade Template

In this task, you will load the upgrade template for your product line.

To load the upgrade template:

1. Launch the Upgrade Assistant.  A blank Upgrade Assistant template appears.  You will load

the Upgrade Assistant with a template for your selected product and path.

2. Select File, Open Upgrade Template.  The Open Upgrade Template dialog box appears.

3. Select the directory in which you stored the upgrade template when you installed the Upgrade

Assistant files.

4. Select the template for your product and path (for example, HRMS 7.5 to 8.0).

The Upgrade Assistant loads the template with the steps for your upgrade product, as shown

below:
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Set the Documentation Directory

Now you will set the Documentation Directory.  The Upgrade Assistant enables you to view the

upgrade documentation, relevant to the step you are performing.  You will select the directory in

which you stored the upgrade documentation when you installed the Upgrade Assistant files.  The

Upgrade Assistant locates the documentation from this directory and loads it into the

Documentation Window.

To set the documentation directory:

1. Highlight the top node (template name) of your template tree.

2. Select Edit, Set Documentation Directory.  The Documentation Directory dialog box

appears:

3. Enter (or browse to) your documentation directory.

The documentation directory is the directory to which you downloaded the upgrade

documentation from Customer Connection.
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4. Select OK.

Now, when you select a task or step in the Upgrade Assistant template tree, the Upgrade

Assistant displays the corresponding upgrade documentation, in the Documentation Window,

as follows:

Define Step Properties

Once you have loaded your upgrade template and set your documentation directory, you need to

define the appropriate properties for each step.  You will actually define properties at the step

level, not the task level.  You will open the Step Properties dialog box to set the properties for

each step in your upgrade.  Setting these properties determines the conditions that apply when

you run the upgrade process.

When you open your template, the Upgrade Assistant displays the tasks only.  You must expand

these tasks to display the steps within each task.  Select the plus sign (+) to expand an individual

task and display the steps within that task.  You can also configure your general settings to
expand all tasks in the upgrade template.

For more information about expanding tasks, see Specifying General Settings.
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To define the step properties:

1. Highlight the step for which you want to assign step properties, then select Edit, Step

Properties.

The Upgrade Assistant displays the Step Properties dialog box:

2. Verify that the step description corresponds to the step you selected.

3. Enter the script or procedure, if one is associated with the current step, in the

Script/Procedure field.  This field is used for SQL scripts, Data Mover scripts, SQRs and

Application Engine Processes.

4. Select a Type from the Type drop-down list.  This selection defines the type for the script or

procedure you selected.

For a discussion of each Type, see Understanding Process Types.

The following lists the available types:

Application Engine

Build Project

Convert Application Engine

Convert Fieldnames

Convert PeopleCode

Convert Workflow

Create Project
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Custom Defined Process

Data Mover - Bootstrap

Data Mover - User

Manual - Stop

SQL Command

SQL Script

SQR Report

Upgrade Compare

Upgrade Copy

Note. If you select Create Project from the Type drop down list, you must set a #Type

parameter.  For a list of parameters, see the next step.

When you select Build Project from the Type drop down list, a Build options button

appears.  You will select options based on the instructions in the upgrade documentation for

your product and path.

For information about build options, refer to Understanding Build Options.

When you select Upgrade Compare or Upgrade Copy from the Type drop down list, the

Upgrade Options push button appears.  You will select options based on the instructions in

the upgrade documentation for your product and path.

5. Enter the Parameters.  You can set additional parameters you need to run your step.  For

SQL commands, you enter the actual SQL command in this field.

The additional parameters are as follows:

Parameter Description

#Project= Used primarily for functions that require a project

name; for example, Build Project, Upgrade Compare,

or Upgrade Copy.
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Parameter Description

#Directory= Used when you need to run a script that is not located

in the %PS_HOME%\scripts directory; for example,

STOREPT.  In this case, you could enter:

#Directory=#PT_PSHOMEsrc\cbl\base\

#P1= through #P5= Used to pass parameters to SQR reports; for example,

DBTSFIX.sqr.  In this case, you would pass the

necessary value, such as:

#P1=3OutputDirectory

#Rename= Used primarily for the Convert FieldNames step type.

It will automatically copy the CONVERT-XXXX.INF

file from the %PS_HOME%\scripts directory into the

c:\temp\ and rename the file to CONVERT.INF.

#PTPS_HOME and

#APPPS_HOME

Used to specify the %PS_HOME% variable that is

defined in the Database Configuration window.

#Output Directory Used to specify the Output Directory variable that is

defined in the Database Configuration window.

#Type Enables you to specify the type of record to insert into

the project.  Choose from the following record types:

All Records

Table

View/Query View

Derived

SubRecord

Stored Procedure

Temporary Table

Dynamic View

6. Select Client or Server from the Run Location drop-down list.  In this field, you indicate

whether to run the particular step, script, or procedure on the Client or a Process Scheduler

Server.

If you choose the Server, the Upgrade Assistant checks the Database Configuration for the

name of the process scheduler.  You will specify your Process Scheduler during the Database

Configuration steps.

Note. Selecting a Run Location applies to Application Engine processes only.



J A N U A R Y  2 0 0 1 P E O P L E T O O L S  8 . 1 2  U P G R A D E  A S S I S T A N T  P E O P L E B O O K

P E O P L E S O F T  P R O P R I E T A R Y  A N D  C O N F I D E N T I A L D E F I N I N G  T H E  U P G R A D E      3 - 7

7. Select the Database Orientation. Select Source or Target from the Database Orientation

drop-down list.  In this field, you indicate whether to run the step, script, or procedure against

the Source or Target database, as defined by the database configuration.  

Note. The default orientation is Target, but in certain steps, such as the Export and Copy

or the Project Compare, you are required to log into the Source first.  In these cases, set the

Database Orientation to Source.

8. Click on the Products icon, as shown below:

The Upgrade Assistant displays the Products dialog box:

This dialog box contains the Products and Product Codes.  You will select the products your

step should be run against.  This feature is used primarily for data conversion processes.

9. Select the product type you want to upgrade from the drop-down list; for example, Human

Resources or Financials, Distribution, and Manufacturing.

10. Select one or more product lines from the checklist.

11. Click OK.  The Upgrade Assistant displays your product selection in the Products field of the

Step Properties dialog box, as shown in the example below:
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12. Click on the Platforms icon.   The Platform dialog box appears:

13. Select the platform you want to run against your upgrade step.

14. Select OK.  The Upgrade Assistant displays your platform selection in the Platform field of

the Step Properties dialog box, as shown in the example below:

15. Select the Language icon. The Upgrade Assistant displays the Language dialog box:

In this field, you select the language(s) you have loaded in your database.

16. Select one or more languages.

17. Select OK.  The Upgrade Assistant displays your language selection in the Language field of

the Step Properties dialog box, as shown in the example below:

18. Select the Type of Upgrade Step.  Select from Initial Upgrade, Move to Production, or

Both.  The default selection is Both.

In this field, you indicate whether to use the step, script, or procedure in the Initial Upgrade,

the Move to Production, or both parts of the upgrade process.  The Upgrade Assistant

automatically filters steps by platform, product, and language.

19. Select the Language Type.
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If you select Installed Language, the Upgrade Assistant will run the step against the

language installed in your database.  If you choose this option, the Upgrade Assistant filters

your upgrade for the current step based on the language you choose on the Database

Configuration, Language tab.  In most cases, you will choose this option.

If you select Base Language, the Upgrade Assistant runs the step against the base language.

This option is used primarily if you are running a step that involves currency scripts.  If you

select this option, you must also select your base language in the Target Base Language drop-

down list on the Database Configuration dialog box.  The Upgrade Assistant then filters your

upgrade, for the selected step, based on that selection.

20. Set your Allow for Errors preference.  Select Yes to allow for errors in the step or No to set

for no errors in the step.  If you set this preference to No, the Upgrade Assistant stops the

upgrade process if it encounters an error.  If you set this preference to Yes, the Upgrade

Assistant continues the run process if it encounters an error.  The default setting is No.

If you select No to the Allow for Errors preference, you can configure the Upgrade

Assistant to notify you, by email, if an error occurs.

For information about setting email notification, see Specifying Email Settings.

21. Select your Run Concurrently preference.  Select Yes to run the step concurrently or No to

run the step individually.  The default setting is No.

The Upgrade Assistant has the ability to run certain upgrade steps concurrently; for example,

you can run several Application Engine, SQR, or SQL scripts simultaneously.  If you answer

Yes to two or more steps, the Upgrade Assistant will launch those processes concurrently,

until it reads a step that has been set to No.

22. When you have completed defining the properties for this step, select OK on the Step

Properties dialog box.  The Upgrade Assistant dialog box reappears:
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The step properties you defined for the current step are displayed in the Description and

Properties section of the dialog box.

23. Repeat steps 1 through 22 for each step in your upgrade.

24. Save the Template.
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Creating and Running the Upgrade Job

Once you have defined your upgrade template, you will create and run the upgrade job.  You will

create the upgrade procedure for your particular environment, using the step properties you set for

your platform, product line, and language combination.

You can create multiple upgrade jobs for each upgrade template.

Create the Upgrade Job

In this task, you will create the upgrade job, then set the configuration.  The Upgrade Assistant

uses your configuration information to filter the upgrade path.

You must load your template and define the step properties before creating the upgrade job.

For information about loading your template, see Defining the Upgrade.

Creating the Upgrade Job

In this task, you will create and name your new upgrade job.

To create the upgrade job:

1. Select the Job Status view on the Upgrade Assistant.

2. Select File, New Upgrade Job.  The Create New Job File dialog box appears.

3. Enter a name for your Upgrade Job; for example, the name of your database.

4. Select Save.  The Database Configuration dialog box appears:
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You will use this dialog box to configure your database properties.

Configuring Your Database

In this task, you will set properties for your database.  You will define your database type, select a

target base language, and set your query executable file.

To configure your database:

1. Select the Database tab.

2. Select your Database Type from the Database Type drop-down list.

3. Select your SQL Query Executable file.  This is the SQL Query tool that you use to run

SQL queries from your Client workstation.  Select from the following:

Platform Utility

DB2/OS390 Use the DB2 Command Center (ex.

DB2CMD.exe)

DB2/UNIX Use the DB2 Command Center (ex.

DB2CMD.exe)

Informix Use the SQL Editor Query Tool (ex.

SQLEDITOR210.exe)

Microsoft SQL Server Use OSQL.exe

Oracle Use SQLPLUS.exe

Sybase Use SQLADV.exe for Sybase 11

Use ISQL.exe for Sybase 12

4. Select your Target Base Language from the drop-down list.  The Target Base Language is
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used for Currency scripts that are run according to the Base language, rather than the installed

language.  If you selected the Base Language option on the Step Properties dialog box, you

must choose the same language here.

5. Enter the following information for each object in the Source column and the Target

column:

Object Description

Database Name Name of the Target (Copy of

Production) or Source database.

User ID PeopleSoft User ID you use to log

into the Target Database.

User ID Password PeopleSoft User ID password.

Host Name Actual Server Name on which the

database server resides (Microsoft

SQL Server only).

Database Server Name Name of the Source or Target

Database Server (Informix, Sybase,

and SQL Server only).

Access ID Owner ID of the Source or Target

Database.

Access Password Owner ID password

Owner ID Choose a table owner ID for the

PeopleSoft tables. The table owner ID

can be either an access ID, a

secondary authorization ID, or a

generic ID.

Specifying the Directories

In this task, you will select your upgrade script staging and output directories.

To set the directories:

1. Select the Directories tab.  The following appears:
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2. Select the PS_HOME Directory.  This is the directory that may be listed on the file server.

The Upgrade Assistant uses this information to retrieve application and PeopleTools scripts

and data files.

3. Select the Upgrade Script Staging Directory.  The Upgrade Assistant edits the scripts

during the upgrade process and locates all the scripts into one central directory.

Note. The Upgrade Script Staging Directory and the Upgrade Output Directory cannot be

the same.

4. Select the Upgrade Output Directory.  The Upgrade Assistant executes all of the scripts and

processes during the upgrade process and sends the output into the Upgrade Output

Directory.

Selecting the Products

In this task, you will select the products to run against your database.

To select the products:

1. Select the Products tab.  The following appears:
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2. Select your Product Line from the drop-down list.  The Upgrade Assistant displays the

products for your product line.

3. Select the checkbox for the product or products you have installed in your database.

Note. Previously, in the Step Properties dialog box, you selected products to apply to your

upgrade steps.  In this part of the process, you select products to apply to your database.

4. Select OK.  The Upgrade Assistant again displays the Database Configuration dialog box.

Setting Your Language Preference

In this task, you will specify the language you have installed in your database.

To set your language preference:

1. Select the Languages Tab.  The following appears:
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2. Select the checkbox for the language you have installed in your database.

Setting the Import and Export Preferences

In this task, you will set your import and export configuration settings preferences.

To set the import and export preferences:

1. Select the Import/Export tab.  The following appears:

2. When you select Import to File, the Upgrade Assistant reads the configuration settings from

a file.

3. When you select Export to File, the Upgrade Assistant writes the current configuration

settings to a file.
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Setting General Preferences

In this task, you will set the Configuration Manager Profile.  In this release, it is necessary to

create individual user profiles for Process Scheduler configurations.  The Upgrade Assistant can

run processes, such as Application Engine processes, on the Process Scheduler server.  The

Upgrade Assistant uses the information you specify for the Configuration Manager and Process

Scheduler to run these processes on the server.

To set general preferences:

1. Select the General tab.  The following appears:

2. Select the Type of Upgrade.   Choose from Initial Upgrade or Move to Production.

When performing the initial upgrade on your Copy of Production, you will want to choose

the Initial Upgrade option.  The Upgrade Assistant displays only those steps that apply to the

initial upgrade.  Give your upgrade job a name indicative of the initial upgrade; for example,

<dbname>_initupg (where <dbname> is your database name).

When performing your test move to production, you will create a new upgrade job and

choose Move to Production as the Type of Upgrade.  The Upgrade Assistant will then display

only those steps needed for the move to production part of the upgrade.  Give your upgrade

job a name indicative of the move to production; for example, <dbname>_mvtoprod1 (where

<dbname> is your database name).

3. In the Application Server/Process Scheduler Configuration section, complete the following

options:

Select the Configuration Manager Profile from the drop-down list.

Select the Process Scheduler Name from the drop-down list.
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For information about Process Scheduler, refer to PeopleSoft Installation and
Administration, for your database platform.

Enter your Application Server Machine Name.  This is the actual server name on which the

application server resides.

Enter your JSL Port (the Jolt Listener Port needed for the component interface).

Enter the FTP information. If you run Application Engine processes on the Server, the

Upgrade Assistant needs to FTP those log files to the Client. Here you need to define the

FTP Server Output Directory for that output, a valid FTP User ID, and the FTP User

Password that can be used to FTP those files from the Server to the Client.  At that point, the

Upgrade Assistant performs Error Checking on those logs, determining whether the process

failed or completed successfully.

4. Select the Application Engine Run Location.  This option sets all Application Engine steps,

located in the Template, to a default Run Location.  By clicking the reset button, all

Application Engine steps will be set to your choice of the following options:

Set All AE Tasks to run on the Server

Set All AE Tasks to run on the Client

Completing the Configuration

Select OK on the Database Configuration dialog box.  Your database configuration properties are

now complete.

The Upgrade Assistant reappears with the steps that apply to your upgrade, as shown in the

example below:
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View the Documentation

You can select the option to view the documentation, relevant to the current step, in the Job
Status view.  You may want to view the documentation as you run the upgrade process.

To view documentation, you must have the documentation directory set on the Upgrade

Template tab.

For more information, see Set the Documentation Directory.

To view the documentation:

1. On the Upgrade Assistant toolbar, select View, Documentation.

2. The Upgrade Assistant displays the documentation in the Documentation Window, as in the

example below:
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Review the Job Status

Before you run your upgrade job, review the status for each step.  These steps automatically
inherit a Run or Manual — Stop status based on your assigned step properties.

The run status is displayed, next to the step, with the following symbols:

Name Symbol Description

Run This green icon indicates that the Upgrade

Assistant will run this step or process.

Stop This red icon indicates that the Upgrade Assistant

will stop on this process.

Restart Indicates a restart process.  The Upgrade Assistant

will stop on these processes and you will have to

restart the Upgrade Assistant after you complete

the manual process.

Processing Indicates that the process is running.

Error Indicates an error.

Complete Indicates that the step is complete.
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Note. You can change the job status of any step by selecting a job status on the Edit menu

or by right-clicking on the step, then selecting the new job status.

Run the Upgrade Job

Once you have created your upgrade job, you can run the upgrade process.

Note. You should still be on the Job Status view.

A typical upgrade job may look as follows:

The upgrade steps are set to automatically run or stop.  If the step type is Manual - Stop, then

those steps are displayed with the Stop symbol. You will need to perform those steps manually.

If a step is set to run, then those steps are displayed with the Run symbol.

Perform a Manual - Stop Step

A Manual - Stop step is a step you must perform manually.

To perform a manual - stop step:

1. Perform the manual step (for example, "Database Platform Notes").
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2. Once you have completed a Manual - Stop step, change the status to Complete by selecting

Edit, Complete.  For example, for the task titled "Database Platform Notes" you can change

the status to Complete after you have finished reading the database platform notes.

Note. The Upgrade Assistant performs the steps in order.  You can perform Manual —

Stop steps, until you encounter a Run step.  The Upgrade Assistant then performs the series

of Run steps, and continues performing the Run steps until it encounters another Manual —
Stop step.

Run an Upgrade Step

Once you have completed the necessary manual steps, the Upgrade Assistant can start the Run
process for you.

To start the run process:

1. Highlight the upgrade step you wish to run.

2. Select Edit, Run (you can also select the run icon on the Upgrade Assistant toolbar).

The Upgrade Assistant starts the Run process.  The Run icon changes to the Processing icon.

The status column changes to Processing.  The Start Time column indicates the time the job

started.

The Upgrade Assistant displays these indicators until the step is complete.

When the step is complete, the status column displays Complete and the Run icon changes to

the Complete icon.  The Upgrade Assistant displays the End Time and Duration in the status

grid, as shown in the example below:
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The Upgrade Assistant runs your next step and continues running steps until it fails or finds a

step with a Stop status.

3. When you have finished the run process, save your upgrade job.

Cancel a Running Upgrade Step

You may need to cancel a step during the run process.

To cancel a running upgrade step:

1. Click the Cancel button on the Upgrade Assistant toolbar.

The Cancel button (represented by an X) is located on the right side of the toolbar.  When you

select Cancel, the Upgrade Assistant displays the following dialog box:

2. Select Yes to cancel the run process or No to continue the Run process.  If you select Yes, the

Upgrade Assistant displays the following dialog box:
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3. Click OK to continue terminating the process.  The following dialog box appears:

Because the step did not complete, the Upgrade Assistant marks the step as failed.

View the Log File

This option enables you to view individual log files and output generated by the Run process.

Viewing the Log File for SQR Reports and Data Mover Scripts

You can view the log file for SQR reports or Data Movers scripts.

To view the log file for SQR reports and Data Mover scripts:

1. On the Job Status toolbar, select Edit>View Log.

 The Upgrade Assistant displays the following dialog box:

2. Select the log file you wish to view.

3. Select OK.

The Upgrade Assistant displays the log file.
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Viewing the Log File for All Other Processes

In this task, you can view the log file for all processes except SQR reports and Data Mover

scripts.

To view the log file for all other processes:

1. On the Job Status toolbar, select Edit>View Log.

2. The Upgrade Assistant displays the log file in Notepad.
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Configuring and Editing Options

In the previous chapters, you learned how to load the upgrade template, configure step properties,

create an upgrade job, and configure your database.  In this chapter, you will learn how to create a

new upgrade template and configure and modify options in your upgrade template.

Create a New Upgrade Template

You can create a custom template for your upgrade, insert tasks and steps, specify step properties,

and configure your database options.

Creating the New Template

You can create an entirely new upgrade template.

To create a new upgrade template:

1. Open Upgrade Assistant.

2. Select the Upgrade Template view.

3. Select File, New Upgrade Template.

The New Upgrade Template dialog box appears:

4. Enter the name of your new template.

5. Select OK.

The Upgrade Assistant displays the name of your new template in the Template Tree.  Now

you can insert tasks, insert steps, and assign step properties for your new template.
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Inserting Tasks

Now that you have created your new template, you will need to insert tasks.  A task is a section

heading for a group of steps.

To insert tasks:

1. Highlight the location where you want to add the task.  If this is the first task in your new

template, highlight the top node (template name) at the top of the Template Tree.

2. On the Upgrade Assistant toolbar, select Edit, Insert Task.

The New Task dialog box appears, as follows:

3. Enter a unique name for your new task.

4. Select OK.

Inserting Steps

After you have created your new template and inserted the tasks, you can insert steps.  A step can

be any script, application engine process, etc., you want to add.

To insert steps:

1. Highlight the task where you want to add your new step.

2. From the Upgrade Assistant toolbar, select Edit, Insert Step.

The Insert Step dialog box appears:

3. Enter a unique name for your new step.

4. Select OK.

The Upgrade Assistant invokes the Step Properties dialog box.

5. Now, you can define the step properties for your new template.
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For more information, see Define Step Properties.

6. Continue creating steps until your template is complete.

7. If you would like to create an upgrade job for this template, select the Job Status view.

For more information, see Create the Upgrade Job.

Add a Task or Step to an Existing Upgrade Template

If you have made customizations to your upgrade, you may want to add tasks or steps to your

existing upgrade template to reflect your customizations.  You can add a task as a section head in

your template, then add steps to reflect the actual customizations your have made to your
upgrade.

Adding a Task to an Existing Upgrade Template

When you add one or more tasks to an existing upgrade template, the task serves as a section

head for upgrade steps.  After creating a new task, you can add steps to the task.

To add a task to an existing upgrade template:

1. Open Upgrade Assistant.

2. Select the Upgrade Template view.

3. Select File, Open and choose your template.

4. Highlight the location where you want to insert a task.

5. Select Edit, Insert Task.

The New Task dialog box appears, as follows:

6. Enter a unique name for your new task.

7. Select OK.

8. The upgrade template reappears and displays your new task.
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9. Save your template.

Adding a Step to an Existing Upgrade Template

When you add one or more steps to an existing upgrade template, you must define step properties

and database configuration options for your new steps.

To add a step to an existing upgrade template:

1. Make sure you are on the Upgrade Template view in the Upgrade Assistant.

2. Highlight the task where you want to add your new step.

3. Select Edit, Insert Step.  The New Step dialog box appears:

4. Enter a unique name for your new step, then select OK.

The Upgrade Assistant invokes the Step Properties dialog box.

For more information about assigning step properties, see the Define Step Properties.

5. Save your template.

Delete a Task or Step

You may want to delete a task or step from your upgrade template.

To delete a task or step:

1. Open Upgrade Assistant.

2. Select File, Open to choose your template.

3. Highlight the task or step you want to delete.

Important!  If you delete a task, the Upgrade Assistant deletes all the steps within the task.

4. Select Edit, Delete Task or Edit, Delete Step.
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5. The Upgrade Assistant deletes the task or step and updates the template.

6. Save the template.

Rename Tasks and Steps

You can rename a task or step in an existing upgrade template.

Important!  If you rename an existing task or step in a PeopleSoft-delivered Upgrade

Template, you will lose the link to the Documentation Window for that task or step.

To rename a task or step:

1. Open Upgrade Assistant.  Make sure the Upgrade Template view is selected.

2. Select File, Open and choose your template.

3. Highlight the task or step you want to rename.

4. Select Edit, Rename.

5. Type in your new task or step name.

6. Save your template.

Edit Your Database Configuration

You can modify the database configuration options you set for your upgrade steps.

To edit your database configuration:

1. Open Upgrade Assistant.

2. Select the Job Status view.

3. Select File, Open Upgrade Job and select your upgrade job.

4. Highlight the step you want to modify and select Options, Database Configuration.

The Upgrade Assistant displays the Database Configuration dialog box.

5. Modify your selected options.

For more information about Database Configuration options, see Create the Upgrade Job.
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6. When you are finished modifying your database configuration options, select OK.

The Upgrade Template reappears in Job Status view.

7. Save your template.

Specify Settings

Using the Upgrade Assistant command on the Options menu, you can specify general settings for

your upgrade template.  You can access the Options, Upgrade Assistant menu from the Upgrade

Template view or the Job Status view.

Specifying General Settings

When you load your upgrade template, the Upgrade Assistant displays the tasks only.  You can

configure the General Settings dialog box to automatically display the steps, within a task, in the

Tree Structure of your upgrade template.  Setting the steps to display when you open your

upgrade template is helpful for defining your step properties.

To specify general settings:

1. Open Upgrade Assistant.

2. Select Options, Upgrade Assistant.

3. The Upgrade Assistant dialog box appears.

4. Select the General Settings tab, as follows:

5. Select Always Expand Template Tree.

6. Select OK.  The Upgrade Template reappears with the Tree Structure expanded to display

tasks and steps.
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7. Save your template.

Specifying Email Settings

On the Task Properties dialog box, you decided whether to allow for errors or not during the

upgrade process.  If you selected No to the Allow for Errors option, you may want to configure

the Upgrade Assistant to notify you, by email, if it encounters an error during the upgrade

process.  You can set the Email Settings dialog box to notify you of any errors encountered

during the upgrade process.

To specify email settings:

1. Open the Upgrade Assistant.

2. Select Options, Upgrade Assistant.

The Upgrade Assistant dialog box appears.

3. Select the Email Settings tab.

4. Select the Send Email Notifications checkbox if you want the Upgrade Assistant to notify

you of any errors encountered during the upgrade process.

5. Under Email Configuration, enter your Mail Server and Email Address.

6. Select OK.

The Upgrade Assistant will notify you of any errors encountered during the upgrade process.

Merge Templates

After the initial release of an upgrade template, it may be necessary for PeopleSoft to release a

maintenance template for your particular upgrade product.
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This option enables you to merge your existing template with a new PeopleSoft-delivered

maintenance release template.

To merge templates:

1. Select Options, Merge Templates.  The Merge Templates dialog box appears:

2. Enter the path and file name of your existing Upgrade Template.  This is the path you

selected when you installed your upgrade template.

3. Enter the path and file name of your new Upgrade Template.

4. You can accept the default Log File Name or specify a different log file name.

5. Select Next.

The Upgrade Assistant merges the two templates.  It then displays the new merged template,

as in the example below:

6. Select View Log.  The View Log lists steps that were deleted, customized steps that were

replaced, and steps that were added in the merge process.  Review the log to ensure that your

merge changes are complete.

7. Select Finish.  The Upgrade Assistant returns you to the Upgrade Template view.
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Understanding Types and Options

This chapter describes the process types and upgrade options available in the Upgrade Assistant.

Understanding Process Types

In the upgrade process, you assign a process type for each step in your upgrade.  This provides

the Upgrade Assistant with information necessary to complete the step.  The following describes

each process types and what each process type will do for your upgrade.

The Upgrade Assistant contains the following process types:

Process Type Definition

Application Engine This selection runs Application Engine

processes in the Script/Procedure value under

Step Properties.  You can run your

Application Engine process on the client, the

server, or in parallel.  You may need to adjust

these to reduce the amount of time needed for

the actual Move to Production part of the

upgrade.

Build Project This selection builds the project specified in

the Task Properties parameter as #Project=

(for example, #Project=ALLTABS).  The

project is built through the PeopleTools

command line.

Custom Defined Process This selection enables you to include custom

added processes, such as Batch files, that you

can run through the Upgrade Assistant.  You

need to start this process with cmd / c for the

process to run; for example:

Cmd / c c:\backup.bat

Convert Application Engine This selection converts Application Engine

processes to the release 8.10 format (GUI

processes).
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Process Type Definition

Convert Fieldnames This selection converts FieldNames to the

PeopleTools release 8.10 format (GUI

processes).

Convert PeopleCode This selection converts PeopleCode

programs to support the newly-supported

Unicode format (GUI processes).

Convert Workflow This type converts Workflow objects to the

PeopleTools release 8.10 format.

Create Project This type enables you to select the type of

records to insert into a project.

Data Mover — User This type runs Data Mover scripts as the

User ID specified in the Database

Configuration (non-bootstrap mode).

Data Mover  —  Bootstrap This type runs Data Mover scripts as the

Access ID specified in the Database

Configuration (bootstrap mode).

Manual — Stop This type is defined as a task you must run

manually.  The Upgrade Assistant

automatically sets the run status to Stop.

Once you have manually completed the step,

you need to change the Job Status to

Complete.

SQL Command This type runs the SQL command defined in

the Parameters value under the Step

Properties.  The Upgrade Assistant runs the

command using the SQL Query tool

specified in the Database Configuration

dialog box.  For most SQL Query Tools, the

Upgrade Assistant will stop on error.

SQR Report This type runs SQRs using the pssqr

command line.

SQL Script This type run the SQL script defined in the

Script/Procedure value under the Step

Properties.  The Upgrade Assistant runs the

script using the SQL Query tools specified on

the Database Configuration.  For most SQL

Query Tools, the Upgrade Assistant will stop

on error.
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Process Type Definition

Upgrade Compare This type runs the Upgrade Compare Process

using the project specified in the Step

Properties parameter as #Project= (for

example, #Project=ALLTABS).  You can

modify the Upgrade Compare Options (for

example, the Report Filters) through the

Upgrade Assistant.  The Upgrade Assistant

uses the options, from the Upgrade Compare,

when running the process (GUI process).

Upgrade Copy This type runs the Upgrade Copy Process

using the project specified in the Step

Properties parameter as #Project= (for

example #Project=ALLTABS).  You can

modify the Upgrade Copy options (for

example, Language options or Objects to

Copy) through the Upgrade Assistant.  The

Upgrade Assistant uses the options, from the

Upgrade Copy, when running the process

(GUI process).

Understanding Build Options

The Build Options dialog box enables you to choose the build options, build execute options, and

settings for your build project.  When you select certain Types on the Task Properties dialog box,

the Build dialog box appears, as follows:

You use the Build dialog box to create or run the SQL scripts that define the underlying database

components.

Selecting Build Options

The Build Options group enables you to specify what action you want to occur; Create Table,

Create Indexes, Create Views, or Alter Tables.

• Create Tables.  Select this option to create tables for your build project.  When you select this
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option, then, by default, Create Indexes will automatically be selected.  You cannot deselect

Create Indexes if you select Create Tables.

• Create Indexes.  Select this option to create indexes for your build project.

• Create Views.  Select this option to create views for your build project.

• Alter Tables.  Select this option to alter existing tables.  When you select this option, then, by

default, Create Indexes will automatically be selected; however, using this option, you can

deselect Create Indexes.

You can select Create Tables and Alter Tables to run concurrently as long as the Skip

table if it already exists option is enabled on the Create tab in the Build Settings dialog.

Otherwise, there would be no way to determine whether you wanted to alter or recreate a

table that already exists.

Selecting Build Execute Options

In this part of the Build dialog box, you can select certain conditions to execute your build

process.  To run the SQL script file that the Build process generates, you must use a third party

SQL interpreter, such as Oracles SQL *Plus or Microsoft ISQL/W.  Most database vendors

include a native command processor that you can run on the client or the server.

This dialog box contains the following Build Execute Options:

• Build script file.  When you select this option, you can review and update the SQL prior to

executing the script. This option is automatically selected for altering tables.

• Execute SQL now.  When you select this option, you do not have to invoke another program

to run the SQL; the SQL runs as part of the Build process.  However, when you select this

option, you don't have the opportunity to review the SQL prior to the SQL committing to the

database.

• Execute and build script. When you select this option, the SQL is executed as part of the

Build process, and the SQL script is saved so you can review it.

Note. You cannot run Build scripts through Data Mover.  The scripts may contain syntax

specific to your database platform that Data Mover is not designed to process.

Choosing Build Settings

You can invoke the Build Settings dialog box to view or change your build options.  The Build

Settings dialog enables you to customize various aspects of the build process.  Depending on

which build option you are running, your build settings will vary.  The settings you chose are

stored on your workstation, so that you can re-use them during future Application Designer
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sessions.  When you select the Settings push button, the Upgrade Assistant invokes the Build

Settings dialog box.  You can use this dialog box to create and alter tables, set view and index

creation options, set log output directories, and set script output directories.

Create Tab

When you select the Create tab on Build Settings dialog box, the following appears:

The Create tab enables you to specify table creation, view creation, or index creation settings.

Table Creation Options

These options determine when a table should and should not be created.  You can select one

of the following options:

• Recreate table if it already exists.  This option always drops and recreates a table if it already

exists.  Use this option with care; if there is any data in the table that already exists, it will also

be dropped.  If you don't want to retain the data in the tables, then this option is faster than

performing an alter.

• Skip table if it already exists.  This option creates only those tables that are newly defined.  If

you want to preserve the data already residing in existing tables or you want to create new
tables, select this option.

The default setting is Skip table if it already exists.

View Creation Options

The following options are available for view creation:

• Recreate view if it already exists.  Since views are logical views of data, you can safely use
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this option; you don't run the risk of losing physical data.  Using this option ensures that all

views in the project are rebuilt, whether they need to be or not.

• Skip view if it already exists.  Choose this option if you only want to create views that don't

already exist in the database.  This option is useful if you want to run the Build Project on a

large project and only a subset of the views in the project need to be created.  This takes less

time than recreating all the views in the project.

The default setting is Skip view if it already exists.

Index Creation Options

These options determine when an index should be recreated.  You can select one of the

following options:

• Recreate index if it already exists.  Select this option when you want to drop and recreate all

of the indexes for your build.

• Recreate index only if modified.  Select this option if you want to have an index recreated

only if the index definition in the PeopleTools tables is different from the physical index.

The default setting is Recreate index only if modified.

Alter Tab

When you select the Alter tab on the Build Settings dialog box, the following appears:

Using the options on the Alter tab, you can select column options, column length options, and

alter options for your build project.
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Drop Column Options

Drop Column Options are referenced whenever a field is deleted from a PeopleTools record

definition and data exists in the database for that column.  You can select from one of the

following options:

• Drop Column if data present.  If you select this option, the column and data will be dropped

and a warning will be written to the build log.

• Skip record if data present.  If you select this option, the alter for that record is aborted and

an error message will be written to the log.  Processing continues with the next record.

The default setting is Skip record if data present.

Change Column Length Options

Change Column Length Options are used whenever the length of a character column is

reduced in PeopleTools and an alter could result in data truncation.  You can select from one
of the following options:

• Truncate data if field too short.  If you select this option, and the alter could result in data

truncation, then the record is altered and a warning message is written to the build log.

• Skip record if field too short. If you select this option, then the alter for the record is aborted

and an error message is written to the build log.  Processing continues with the next record.

The default setting is Skip record if field too short.

Alter Any

Alter Any enables custom alter processing for Adds, Changes, Renames, and Deletes.  These

options refer to recfields (adding a field to a record, changing a field on a record, renaming a

field, or deleting a field from a record).

Alter Even If No Changes

This checkbox forces an alter, even if no changes are made to the tables.  The check box is not

checked by default.

Alter Table Options

You can select from the following options:

• Alter in Place

• Alter by Table Rename

The default is Alter In Place.  With Alter In Place, ALTER SQL statements are used to make

the necessary changes to the tables, such as adding, deleting, redefining, or renaming

columns.  For database platforms where Alter in Place is not supported, the alter will

automatically be done by Alter by Table Rename (even if the checkbox is not set to that
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option).  By selecting Alter by Table Rename, a temporary table is created using the new

record definition and the data from the original table is inserted into the temporary table.  The

original table is then dropped and the temporary table is renamed to the original table.

Logging Tab

When you select the Logging tab on the Build Settings dialog box, the following appears:

One way that you can monitor the build process is to review the log files that the build process

automatically generates.  Keep in mind that the log file is entirely separate from the script file.

How much information the log file contains is up to you.  You can set your logging option so that

all status appears in the log, or you can specify that only the errors or warnings appear in the log.

Logging Level

Select one of the options in the Logging Level group to specify the detail of information that you

want in your Build log output.  If you are only interested in the operations that failed, then select

Fatal errors only.  You can add warnings to that mix by selecting Fatal errors and warnings.

If you want to see everything that processed successfully and all of the errors and warnings, then

select Fatal errors, warnings, and informational messages.

Logging Output

The Logging Output group enables you to specify where, and in what form, you would like to

view your log output.  You have the following options:

• Log to output window.  This option writes the same information that would appear in the log

file to the Application Designer Window.  Always be aware of the level that you've selected.  If

there is a lot of detail (high logging level plus many records to process) it may be easier to print
the logging information to a file, and print it later.
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• Log to file.  This option writes the log to a file.  If you select this option, you can specify a

custom location and name for your log file in the Log file name edit box.  If you do not select

this option, the edit box will be disabled.

• Log settings.  This option writes all of the runtime options to the log.  Should it be necessary

to report a problem with the Build process or to troubleshoot, it is important to know the
settings that were active.

• Log file name.  This option enables you to specify a custom location and name for your log

file.  This option is available only if you select the Log to file option.

Scripts Tab

When you select the Scripts tab on the Build Settings dialog box, the following appears:

If you choose to build a script file, then the build process generates a script file containing all of

the Create and/or Alter SQL statements, so that you can review them prior to running the SQL

through another SQL command processor.

Comments

This field enables you to Write Alter comments to script.  This check box is simply a switch

that enables you to either include or suppress alter comments.

Script File

The default for the Save as Unicode checkbox is set, based on the combination of the

UNICODE/ANSI build and the UNICODE/ANSI database.  This checkbox is enabled only when

using MSSQL Server and Oracle databases.  For all other platforms, the checkbox is permanently
disabled, since the script files will always be ANSI.
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Script File Options

If you want all of your Create Table statements written to one SQL script file and your Create

Index statements to another, then select the Output to separate files option.  If you prefer to

have all your statements (Create, Alter, etc) contained in a single file, then select the Output to

single file option.

File Overwrite Options

This option indicates whether you want to automatically overwrite or be prompted before script

files are overwritten.  Your personal preference determines which technique you employ.  If you

don't mind have your previous builds overwritten, then select Always overwrite.  If you are more

comfortable being alerted when a script is about to be overwritten, then select Prompt for each

overwrite.

Script File Names

The options available to select in the Script File Names group box depend on your selection

in the Script File Options group.

• Output to Single File

When you have Output to single file selected in the Script File Options group, just one edit

box appears in the Script File Names group box; All Output File Name.

• Output to Separate Files

If you have Output to separate files selected in the Script File Options group, the following

four edit boxes appear—one for each build option—in the Script File Names group box:

� Create Table File Name

� Create Index File Name

� Create View File Name

� Alter Table File Name

Instead of hard-coding the output paths, you can use the Upgrade Assistant parameter

#OutputDirectory or #InputDirectory to dynamically set the script and log directories, as in

the example below:
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For more information about build options, see Building SQL Tables and Views in

PeopleTools Application Designer.
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